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English/Language Arts

Grades:  9-12

Wise Words
Making Meaning, Building Vocabulary

Tools

Kit software:  Get A Clue;

mPOWER

Other:  Computers; the

Internet; AppleWorks; EdView

Optional:  A digital camcorder;

iMovie; Inspiration

Project Duration

Open

Introduction

The English language is rich with words, each offering a specific shade of meaning. The more of

these words students know, the better and more precisely they can express themselves, and the

more readily they can understand others’ speech and writing. How can students help each other

build their vocabularies? How can we instill in students a lifelong love of words?

Project Overview

In this ongoing, low-intensity project, students learn new words with Get A Clue during otherwise

unscheduled class time and collect unfamiliar words from their reading outside of class. All these

words are added to a class database that includes the words and their definitions, derivations,

synonyms, antonyms, and related forms. The database continues to grow throughout the quarter,

semester, or year; students then work in groups to create multimedia presentations about the

words in specific segments of the class database.

Phase 1: Learning words with Get A Clue

During appropriate times (study time, after class, in between other tasks), individuals or pairs

complete lessons in Get A Clue, software which helps students build their vocabulary through

inductive reasoning. After each session, students print the review sheets for the words they have

investigated. Then they open the class’ “Wise Words Database” (see the “Wise Words Database

Template” on the kit Web site) and check to see if those words are in the database. They enter

each new word, along with its part of speech, derivation, definition, antonyms, synonyms, and

related forms. They also use the word in a sentence from which the word’s meaning can be

inferred.
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Phase 2: Building the database

Throughout the quarter, semester, or year, students collect unfamiliar words from their school or

personal reading. Using available library resources or the Internet (see the Resources section),

students discover the definition and derivation of each word, find synonyms, antonyms, and related

forms, and write a sentence using the word. Then, they open the “Wise Words Database” and add

each new word and its information.

Phase 3: Creating presentations

When the “Wise Words Database” has grown to a sufficient size, divide the class into groups of

three or four, and assign each group an equal portion of the words in the database. Then charge

each group with the following task: Create an mPOWER presentation for the class that will

permanently integrate at least 20 words from the group’s word list into the vocabularies of each

student in the class. The mPOWER slides can include images (retrieved from the Internet or

created with AppleWorks drawing or painting tools), sounds (recorded in mPOWER), and desktop

movies (created with a digital camcorder and iMovie); the presentations overall may employ humor,

drama, music, audience interactivity, creative writing, and multimedia, and should include narration

by the group.

When the presentations are complete, invite groups to take turns delivering them to the class.

Technical and Facilitation Tips

Facilitation Tips: Phase 1

m The ongoing nature of this project makes it possible to carry it out with only a single computer.

This computer can host both the Get A Clue application and the “Wise Words Database.” If

more computers are available, they can host additional Get A Clue applications (but the database

should remain on a single computer).

m Get A Clue includes 15 separate “Series,” each encompassing 20 words. The Series are divided

into five categories: Roots and Prefixes, Strange and Unusual Words, Words Commonly

Confused, Mythical and Historical Allusions, and Foreign Words. In each category, the series

are at three levels. Students will profit from any approach to choosing series and categories,

even if it is haphazard, but you may want to establish more formal guidelines.

m Get A Clue keeps track of each student’s progress. A student can complete any number of

lessons (words) in a level, and then return to complete the others later.

m Each printed Get A Clue review sheet provides students with the derivation of the word, as well

as multiple hints that together can be used to construct a definition. The hints may also suggest

synonyms. Otherwise, students must do their own thinking, brainstorming, and additional

research to fill in all the fields of the database record. For formal definitions, students can

consult a dictionary, which will also provide some related forms. A thesaurus can be used to find

synonyms and antonyms.
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m Communicate to students that the “Wise Words Database” is a cooperative class project, and

that all students are expected to contribute to making it grow and refining its contents. All

students are also responsible for maintaining the accuracy of all the records, no matter who they

are created by.

m When students discover that a word is already in the database, they can use this opportunity to

become even more familiar with the word. They can review the synonyms and antonyms listed,

evaluating how close the meanings are to the main word, and they can review the related forms

of the word, perhaps even adding some the previous student or students did not think of.

m Students’ time is best spent entering entirely new words, rather than other forms of existing

words. For example, if “allocate” is in the database, the noun form, “allocation” need not be

entered separately. If students need to decide which form of a word to use, a good general rule

is to give priority to the verb form.

m Suggestions for how to add potentially problematic words to the database:

m Words that are simultaneously verbs and nouns. For such words, students can create

two separate database records, one for the noun form, and one for the verb form.

m Words with two or more very different meanings. Each meaning should have its own

record in the database. This will make it easier to supply meaningful synonyms and antonyms,

and to write sentences using the different meanings of the word.

m Words with two or more similar meanings. Students should use their best judgment: Are

the meanings different enough to justify separate database records?

m In the AppleWorks database, the Find function (choose Find from the Layout menu) can be

used for a variety of purposes. For example, students can enter a Latin root into the Derivation

field to find all the words derived from that root.

m If a student or students find a database record that includes information they believe is

inaccurate, they can consult with the creator of the record and decide together—with the

assistance of the teacher or an authoritative source—whether the record should be changed,

and if so, how.

Tech Tips: Phase 1

m To print a review sheet for each word studied during a session with Get A Clue:

1 From the Score Card screen, click Review Words.

2 Select a word from the list on the left.

3 Click Print.

m To print words from a level or series different from the one just completed, click the Series

name (to the left of the red triangle). This opens a menu that lists all of the series and levels a

student has worked on. Selecting one of these provides access to the words in that series and

level.

m Get A Clue is designed for students to work with individually. Each student logs in to begin a

session, and the software keeps track of each student’s progress. It is possible, however, for a

pair of students to log in (they can type both their names) and complete lessons together.
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m To check the AppleWorks database to see if a word is entered or not, follow these steps:

1 With Browse or List chosen from the Layout menu, choose Show All Records from the

Organize menu.

2 Choose Sort Records from the Organize menu and click OK.

3 Scroll through the records, which are listed alphabetically.

m An alternative method of checking the database to see if a word exists (or to find a word), is to

use the Find function:

1 Choose Find from the Layout menu.

2 Type the word in the Word field.

3 Click the Find button (or press the Return key). All the records containing the word that was

typed are displayed (for this reason, it is best to type all or most of the letters of the word to

be located).

m To create a new record in the database (that is, to add a new word):

1 Choose New Record from the Edit menu.

2 Enter the appropriate information in the fields of the record, using the Tab key or the mouse

to move between fields.

Facilitation Tips: Phase 2

m You can establish a certain expectation for the number of new words each student should bring

in per week or per quarter.

Tech Tips: Phase 2

m See the Tech Tips for Phase 1 for tips related to managing the “Wise Words Database.”

Facilitation Tips: Phase 3

m Before groups begin creating mPOWER slides, they may want to create storyboards for their

slideshows. The “Storyboard Card Template” and the “Storyboard Example” (located on the kit

Web site) may be helpful for this purpose.

m The content of each mPOWER slide can be left open to allow room for student creativity. At

minimum, however, slides should include examples of how the word is used, as well as a

definition and/or synonyms.

m Encourage groups to include in their presentations some kind of audience interaction. A group,

for example, might ask for examples of how the word could be used in a sentence.

m A digital camcorder and iMovie can be combined to create compelling desktop movies to place

on the mPOWER slides. For example, students can record a person acting out the action of a

verb. In addition, a group could create a desktop movie of a skit that features dialogue made up

mostly of words from the group’s list, and then they could place this movie on a slide that

concludes the presentation.

m The presentations can be completed in one to three class sessions, depending on how

elaborate groups want to make their presentations. For all the groups to deliver their

presentations, you will probably need two class sessions.
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Tech Tips: Phase 3

m In mPOWER, students can write speaker notes to go with each slide. When these notes are

printed, they include a thumbnail view of the slide, and can therefore serve as a helpful script for

narrating a slideshow. To create speaker notes in mPOWER:

1 Click the Notes button in the second row of buttons below the view window (in the

Presentation menu, you will need to select the slide first).

2 Type the speaker notes. The limit is 32,000 characters.

3 To print the notes for the current slide, click Print Notes (the notes for a slide cannot be

viewed during a presentation, so printing them is advised).

m mPOWER can be used to record sounds, which can be placed on slides to help illustrate a

word’s meaning. To record sounds with mPOWER:

1 From the mPOWER menu, choose Preferences, and then choose Components.

2 Select one of the No Port items in the Port box, select Generic Audio in the Supported

Components box, and click the Add button under this box.

3 Select Generic Audio in the Attached Components box. Below this box, in Component

Settings, click the Sound button, and then choose Source from the pop-up menu and

choose the external or built-in microphone.

4 Click OK and then Configure. Return to the mPOWER menu.

5 Open a presentation (a one-slide presentation can be created just for this purpose). From

the Slide menu, choose Audio.

6 Choose Add New Audio, select the microphone source, and click OK.

7 Click the Start Recording button to start recording, then press the Escape key or click the

mouse button to stop recording.

8 Choose a method of saving the audio file and click OK. If you save the sound on a disk, a file

is created that can then be used in any presentation.

m For help using iMovie, students can visit the “Desktop Movies in Education” Web site.

Outcomes

After completing this project, students will be able to

m define or use correctly many previously unfamiliar words

m identify the meaning of a number of common Latin roots and prefixes

m examine many unfamiliar words and guess their meaning by looking at their roots and prefixes

m add, sort, search, and edit records in a database

In addition, students will have

m gained facility in guessing the meaning of unfamiliar words through a variety of techniques

m built their working vocabularies

m developed their skills in recognizing the related forms (verbs, nouns, adjectives, adverbs) of

given words
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m developed skills in written, oral, and visual communication and the organization of information

m gained confidence and skill in their abilities to work in groups and contribute to a common goal

m practiced creating and delivering a slideshow presentation

m learned skills or acquired knowledge relating to each of the state and national standards referred

to in the Project Standards section

Project Standards

From the Secondary Language Arts & Social Studies Web site, you can identify select state

curriculum standards and national educational technology standards that correlate to this student

project. To locate these standards, go to the kit Web site and click the Curriculum button. Locate

and open this student project and click the “Project Standards” button.

Assessment Suggestions

m For Phase 1, Get A Clue provides a variety of means for students to track their progress and

assess their performance. The Diagnostic Exam can be completed before a student completes

any lessons, and helps the student decide which level to begin with. A student can complete the

Achievement Exam toward the end of the project to assess his or her overall achievement. In

addition, after completing all 20 lessons (words) in a level, a student has an opportunity to take a

quiz evaluating the student’s knowledge of the words in the lessons.

m Students’ work in the database can be evaluated by reviewing the records created by each

student and assessing each record based on criteria related to accuracy, completeness, and

clarity. (The Find function, applied to the “Record Created by” field, can be used to search for

all the records created by an individual student.)

m In Phase 4, groups’ presentations can be peer-assessed by means of a rubric including items

such as the following:

m The presentation was engaging and kept my attention.

m The presentation helped me remember the words and how they are used.

m The presentation helped me build my vocabulary.

m I will be able to use most of the words presented in my writing from now on.

Preparation

m Download the “Wise Words Database Template” and put it on the computer that will be used

for building the database during the project.

m Review and print any of the Step-by-Step Cards that students may find helpful during this

project. These include “Creating a Database With AppleWorks 6,” “Making a Presentation With

mPOWER,” and “Finding Clip Art and Photographs on the Web.”

m Secure the use of a projection device for the presentations in Phase 4.
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Resources

Internet

AllWords.com

http://www.allwords.com/

The American Heritage Dictionary of the English Language

http://www.bartleby.com/61/

Desktop Movies in Education

http://www.apple.com/education/dv/

Dictionary.com

http://www.dictionary.com/

EdView

http://edview.apple.com

Merriam-Webster Online Dictionary and Thesaurus

http://www.m-w.com/dictionary.htm

Reference Resources for Writers Directory

http://www.writerswrite.net/refsrch.cfm?search=dictionary

Vocabulary Builder

http://www.palosverdes.com/jesse/pvphs/www-freecollege-com-vocab.htm

A Word A Day

http:// www.wordsmith.org/awad/

WordOrigins.org

http://www.wordorigins.org/home.htm

Wordsmyth

http://www.wordsmyth.net/

Yourdictionary.com (with synonym dictionary)

http://www.yourdictionary.com/

Step-by-Step Cards

m Creating a Database With AppleWorks 6

m Finding Clip Art and Photographs on the Web

m Making a Presentation With mPOWER

Templates

m Wise Words Database Template

Additional Resources

m Storyboard Card Template

m Storyboard Example

m Multimedia Development Checklist
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Prerequisite Skills

To complete this project successfully, students should be able to do the following:

m use a mouse to navigate through a multimedia application by clicking icons and links

m use AppleWorks to create new records, edit existing records, and search for specific records in

a database (see the Step-by-Step Card “Creating a Database With AppleWorks 6”)

m make a multimedia slideshow presentation with mPOWER (see the Step-by-Step Card “Making

a Presentation With mPOWER”)

Background Information

Here is some information you may find useful as you plan how to implement this project or

introduce it to your students.

m Building one’s vocabulary is more than a matter of memorization. When students learn to reason

inductively to discover the meaning of words, to recognize the common components (roots

and prefixes) of many of the more difficult English language words, and to appreciate how new

words help them express themselves more clearly, their vocabularies increase naturally.

Options and Extension Activities

Options

m If a projection device is not available, groups can deliver their presentations to small groups of

students.

m Groups can use Inspiration to plan and storyboard their presentations in Phase 3.

Extension Activities

m Students can build a separate database of Latin and Greek roots and prefixes.

m Challenge students to write sentences, essays, letters, poems, or short stories that make use of

as many of the words in the database as possible.

m Export the mPOWER presentations as HTML files, post them on the Web, and encourage

family members and students from other classes to visit the site.

The Home-School Connection

m Materials that students read at home can be an excellent source of new and unfamiliar words for

the “Wise Words Database.” In addition, students can enlist family members for help in coming

up with synonyms, antonyms, and related forms for their words.
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This Project as a Model

The core of this project—creating a database and adding to it through a school year—can be applied

in several other ways. Possible subjects of databases include authors, memorable quotes, and works

of literature.


